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1.1

1.2.

1.3.

SOP Literature Reviews

1. Introduction

Purpose

The purpose of this Standard Operating Procedure (SOP) document is to provide a clear
and systematic framework and the governance for conducting scoping, rapid and
systematic literature reviews. It applies to reviews incorporating diverse evidence sources
such as qualitative and quantitative data, grey literature, expert opinions, and mandatory
standards. It is applicable in the context of reviews addressing both human and non-human-
related questions.

This SOP aims to ensure consistency, transparency, and rigor in the review process,
enabling the identification, appraisal, synthesis, and reporting of evidence in a structured
and replicable manner.

Key Terms and Definitions

This section provides definitions for key terms used throughout this SOP. These terms are
essential for understanding the processes, evidence types, and methodologies discussed in
the document. The definitions ensure clarity and consistency in how the concepts are
interpreted and applied.

Term Definition

Evidence from Information provided by manufacturers. When integrating such
manufacturers evidence, it is crucial to explicitly address and consider any conflicts
of interest. Consulting independent experts can help provide an
unbiased interpretation of the data presented by manufacturers.
Expert opinion Insights from subject matter experts, including published editorials,
commentary articles in peer-reviewed journals, panel discussions at
professional conferences, or direct consultations. In reviews, expert
opinions supplement empirical evidence by providing reasoned
judgments that can support or challenge existing findings.

Finding A finding is the synthesis of evidence extracted from multiple reports
that fully or partially answers a review question. There may be
multiple findings under a single review question.

Grey literature Research material that is either unpublished or published outside of
traditional peer-reviewed journals. This includes government reports,
technical papers, theses, conference papers, and manufacturer
documents.
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1.4.

SOP Literature Reviews

Term Definition

Peer-reviewed

empirical

studies

Qualitative Research that explores people's experiences, perceptions, and

studies meanings using methods like interviews, focus groups, or
observations.

Quantitative

studies

Record Used during the screening stage to refer to the title or abstract (or

both) of a report indexed in a database or website (such as a title or
abstract for an article indexed in Medline). Records that refer to the
same report (such as the same journal article) are “duplicates”;
however, records that refer to reports that are merely similar (such
as a similar abstract submitted to two different conferences) should
be considered unique.

Overview of Responsibilities

This section outlines the responsibilities of each role involved in the review process,
including the Lead Author (Healthcare Scientist (HCS)), Supporting Authors (HCS), Lead/
Principal HCS, Subject Matter Experts (SMEs), Commissioner, Consultation Groups and
Information Officer.

Lead Author (HCS):

The Lead Author is responsible for all aspects of the review and should be considered
the first line of contact for any queries and discussions regarding its content.

Liaises with the Commissioner to gather the required information to initiate the work.
Leads/ chairs all the meetings related to the review.

Liaises with the Lead/ Principal HCS to ensure the proposed timeline for the review is
feasible and meets internal deadlines.

Keeps an overview of the scope and timeline.

Liaises with SMEs allocated to the review, ensuring clear and timely communication,
and meets with them on a regular basis to ensure thorough discussion of the topic and
address any issues that arise.
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SOP Literature Reviews

Responsible for setting up a group chat on Microsoft Teams, ensuring all HCS involved,
including the Lead/Principal HCS, are included.

Shares relevant information with other HCS when it is pertinent to the tasks they are
working on.

Regularly checks in with the team, at least once a week, to discuss decisions and
progress.

Seeks assistance from other HCS if there is insufficient time to complete the task.
Liaises with other relevant parties when required throughout the review process.

Formats the Evaluation Tool that goes out to consultations groups along with
consultation items.

Ensures all draft documents have been signed off by the SMEs/Commissioner.
Is responsible for final checks of any drafts following SMEs/ Commissioner sign-off.

Liaises with the Information Officer to ensure accessibility of drafts for consultation of
protocol and final report and publication on the NHSScotland Assure (NHSSA) Website.

Additionally, coordinate with the designated HCS for uploading of the final report on Q-
Pulse and update the HCS Technical Landing Page.

Assess the suitable of the literature review for publication in a peer-reviewed journal. If
suitable, the lead author is responsible for formatting the review in accordance with
journal guidelines, managing the submission process, and addressing required
amendments throughout the review process.

Responsible for keeping the file [Year-Year] HCS Tech Review Timeline’ updated for
the literature review.

Ensures that all the review documentation is appropriately saved and filed in the correct
locations including sign offs and correspondence.

Supporting Author (HCS):

If carrying out a two-person review, the Supporting Author will have joint responsibility
for developing the protocol, search strategy, screening, retrieving and requesting reports
from the library, and conduct the grey literature search.

Perform ‘check’ of the critical appraisals and data extraction, subject to resource
availability and type of literature review.

Provide feedback on the confidence assessments drafts.

Actively engage in discussions with SMEs and attend regular meetings, taking the lead
when the Lead Author is unavailable.

Responsible for conducting a detailed proofread of the final written literature review and
appendices, ensuring all citations and references are correct and traceable back to the
original source.
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When publishing in a peer-reviewed journal, responsible for proofreading all the
revisions leading up to the publication.

Keep the file [Year-Year] HCS Tech Review Timeline’ updated for their part.

Othe Supporting HCSs:

These individuals are not directly involved in the review but can provide essential support,
such as:

Retrieving records.

Conducting a detailed proofread of the final written literature review and appendices,
ensuring all citations and references are correct and traceable back to the original
source.

Conducting a gap analysis of suitable journals if the literature review is suitable for
publication in a peer-reviewed journal, considering potential costs and impact factor.

Lead/ Principal HCS?:

The Lead/ Principal HCS is responsible for assigning members of the HCS team to
literature reviews and agreeing on proposed timelines.

Provide a sense check and feedback on the protocol, search strategy, confidence
assessments, final report and supporting material prior to sign-off.

Responsible for singing-off on the final search strategy.

Responsible for commissioning the literature review using the NHSSA commissioning
process when a review is not part of the annual work plan.

Attend regular review team meetings when available.

Subject Matter Experts (SMESs):

Responsible for supporting the HCS team throughout the literature review, providing
relevant supporting materials and additional insight when required.

Identify appropriate working groups and individuals for the consultation group, introduce
the Lead Author to these groups, and communicate the required input for effective
collaboration.

Share calendar availability with the HCS team to facilitate the scheduling of recurring
meetings. Attend scheduled meetings on a regular basis or, if unable to attend, re-
arrange a suitable date.

1 These tasks are typically assigned to the Lead HCS. However, in the absence of a Lead HCS, the Principal
HCS will assume some of these responsibilities.
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1.5.

SOP Literature Reviews
e Be available for ad-hoc contact.

e Review and provide feedback on the protocol and final report and contribute to the
confidence assessments.

e Review consultation feedback and draft responses.

Consultation Group:

e Review and provide comments, in a timely manner, on the protocol and final report.

e Declare any conflict of interest.

Commissioner:

e Assign at least one SME to work closely with the HCS team, ensuring that expert input
is provided throughout the process.

e Review and sign off on the protocol and final report for consultation, as well as their final
versions.

e In some instances, the SME also acts as the Commissioner of the work. In this situation,
they will take on the responsibilities of both the Commissioner and the SME.

Information Officer:

e Ensure correct formatting of the protocol and literature review report and adherence to
branding guidelines.

e Verify the functionality and accessibility of documents.

e Upload the protocol and literature review report to the NHSSA website.

Types of Literature Reviews

This SOP applies to three types of literature reviews:
e Systematic Literature Reviews

e Rapid Reviews

e Scoping Reviews
For detailed definitions of these review types, please refer to Appendix A.

Below is an overview of the characteristics that differentiate these review types, including
the number of authors involved, the search and selection processes, data extraction, critical
appraisal, and consultation. A table summary comparing the key characteristics of the
review types can be found in Appendix B.
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1.6.

1.7.

1.8.

1.9.

1.10.

1.11.

1.12.

1.13.

SOP Literature Reviews
Systematic literature review

Number of Authors

These reviews involve two authors: a Lead Author and a Supporting Author. Additional
reviewers may be involved for specific tasks as needed.

Search

Searches are conducted in all relevant databases, including grey literature when applicable.
They are reviewed by a Librarian and require citation searching.

Study Selection

Both authors will independently conduct the first screening of titles and abstracts, followed
by a second screening of full texts for eligible studies. Any disagreements will be resolved
through a consensus meeting. If consensus cannot be reached, a third reviewer will make
the final decision.

Data Extraction and Critical Appraisal

The Lead Author is responsible for extracting the data using a piloted form, as agreed upon
in the protocol, and for critically appraising the methodological quality of eligible reports.

The Supporting Author will perform a full check of the data extraction and a 30% check of
the critical appraisals.

Confidence Assessments

Confidence assessments will be a collaborative effort involving the Lead Author, Supporting
Author, Lead/Principal HCS, and at least one Subject Matter Expert (SME).

Consultation and Publication

Both the protocol and final report, along with confidence assessments, will undergo
consultation unless the commissioner specifies otherwise.

They are published on the NHSSA website.

Rapid Literature Reviews

Rapid reviews are a type of evidence synthesis which follows a condensed version of the
systematic literature review process, shortening stages and removing the methodological
guality assessments for the purpose of reducing the timeframe. Usual time for completion is
around 2- 4 weeks, but this can vary widely per rapid review.

Number of Authors

These reviews involve one author.
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1.14.

1.15.

1.16.

1.17.

1.18.

1.19.

1.20.

1.21.

SOP Literature Reviews

Review questions and inclusion criteria will be developed in conjunction with the
Lead/Principal HCS and SMEs.

Search

Searches are conducted in general databases, with a limited number of specialised sources
(one or two) if time permits. Citation searching and grey literature may be restricted. If time
allows consultation with the librarian can be considered.

Study Selection

One author will conduct the screening. For uncertainties, another HCS can be consulted.
Data extraction and Critical Appraisal

Conducted by one author.

Data extraction may be limited to essential items; existing systematic reviews can be used.
Critical appraisals are generally omitted for rapid reviews.

Synthesis and Confidence Assessments

The confidence assessments will be conducted by the Lead Author, with SME consultation
if time allows. Since methodological quality is not assessed, proxy indicators such as study
design and journal reputation will be used to assess confidence.

Consultation and Publication

Rapid reviews typically do not undergo consultation. However, if time allows or if deemed
appropriate, the rapid review may be sent to the relevant short-life working group(s) for a
brief consultation period.

They are not published on the NHSSA website. They are sent directly to relevant SMEs.

Scoping Review

Number of Authors

Two authors: a Lead Author and a Supporting Author.
Search

Conducted in all relevant databases, including grey literature if applicable. They are
reviewed by a Librarian and require citation searching.

Study Selection

Both authors independently conduct the first and second screening. Disagreements are
resolved through a consensus meeting or a third reviewer if necessary.
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1.22.

1.23.

1.24.

2.1.

2.2.

2.3.

2.4.

SOP Literature Reviews

If resources are limited, alternative approaches regarding the number of reviewers and their
level of involvement will be agreed upon with the Lead/Principal HCS. For example, the
authors may collaborate, or the process may be conducted solely by the Lead Author.

Data Extraction and Critical Appraisal

The Lead Author is responsible for extracting the data using a piloted form, as agreed upon
in the protocol. If resources allow, the Supporting Author will conduct a 30% check of the
extracted data.

Critical appraisals are not performed for scoping reviews.
Confidence Assessments

Confidence assessments are not performed for scoping reviews.
Consultation and Publication

Both the protocol and final report will undergo consultation unless the commissioner
specifies otherwise.

They are published on the NHSSA website.

2. Administrative and Quality Control

Literature Review Timeline

When initiating a new literature review, the first stage requires the Lead Author to create a
sheet for that specific review within the excel file named ‘[Year-Year] HCS Tech Review
Timeline’, accessible at 2024-2025 HCS Tech Review Timeline.xlsm. The file should be
used to record the hours and days taken for each task of the literature review.

To create a new sheet, the ‘Template’ sheet must be right-clicked, and ‘Move or Copy’
selected. In the dialogue box, ‘Template’ should be selected, the ‘Create a copy’ option
checked, and the new sheet renamed with the review's short title, such as ‘Mass Timber
SR’. The title should end with the acronym 'SLR' for systematic literature reviews, 'SR’ for
scoping reviews, or 'RR' for rapid reviews, as applicable.

The template sheet contains all tasks required in the literature review, including the
estimated time necessary for each task to be completed and the individuals involved in
each task. These estimates are subject to future adjustments as the HCS Team gains more
experience from new reviews.

The Lead Author and Second Author are responsible for filling their respective sections of
the sheet (indicated in the ‘persons involved’ column). The Lead Author is also responsible
for the completion of the tasks attributed to the SMEs, Lead/ Principal HCS, and
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2.5.

2.6.

2.7.

2.8.

2.9.

SOP Literature Reviews

Consultation Group. The Lead Author has the overall responsibility for the management of
the timeline and ensuring all the sections are completed and updated.

It is recommended to update the timeline daily after each contribution to the literature
review by the HCS, as well as actions performed by the SMEs or Lead/Principal HCS, to
prevent forgetting important details. This record will support weekly team meetings for
reporting progress and adjusting timelines as needed.

A review at the end of the year will be conducted for all literature reviews to reevaluate and
adjust the estimated timelines (sheet template) as necessary.

The boxes of ‘reality time’ (reality days and reality hours) spent on a task may deviate from
the estimated — whether shorter or longer. This will be automatically highlighted in green or
orange, allowing the HCS team to review estimated times for future projects. A comment
should be added in the same line as the task, under the column ‘Notes’, to detail the
reason, such as annual leave, illness, prioritising other work, a high number of meetings,
additional hours dedicated to the review.

The estimated times assume a maximum of 5 hours per day to the literature review, within a
7.5-hour workday. If a reviewer works additional hours in a day due to a compressed
workweek, the expected daily hours dedicated to the review should increase accordingly.

In the sheet, three columns are editable. A description and required input for these can be
found below.

Table 2.1 — Column description and input required in the Literature Review Timeline file

Column Description Required
Input
Reality Days This column automatically calculates the days None

spent on a task based on the entered Start Date
and End Date.

Reality Hours This column is for the number of consecutive hours | xx Hours
worked on a task. For example, working 2.5hrs one
week and 2.5hrs the following week would be 5hrs
worked on the task.

Start Date Use this column to insert the date you started the DD/ MM/
task. YYYY

End Date Use this column to insert the date you finished the | DD/ MM/
task. Note: The Start and End date are used to YYYY

document an accurate picture of when you start
and finish a task and allow to see how much time
we can assign for reviews and how much time we
work on other projects. For example, the task of
‘Grey Literature Search’ is an estimated 5 days
(25hrs) but if we start this on 01/ 02/ 24 and finish
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2.10.

2.11.

2.12.

2.13.

2.14.

2.15.

2.16.

SOP Literature Reviews

Column Description Required
Input

on 01/ 05/ 24 we can see either we have done
other tasks in-between times or we have been
working on other projects. It allows us to see if we
have different workloads during different months in
the year.

Notes Use this column if you want to provide notes on the | Free text
task

Document Control

This SOP adheres to the NSS document version control and naming conventions.

When naming files, the year or date, if relevant for final documents, should be indicated
first, followed by the title of the review and the document type (e.g., [YEAR] Fire
Suppression SR Report V01.0 (Final) or Fire Suppression SR Review Tool V00.1 (Draft)).

The version number of a document in draft format will always begin at V00.1 (Draft),
indicating its draft status. Version V00.2 (Draft) will reflect the second version of the draft,
V00.3 (Draft) the third version, and so forth.

Revisions made by the Lead Author and Supporting Author should always be kept under
the same draft version. For version control purposes, these are treated as contributions
from a single author. However, when amendments are needed based on suggestions from
the Lead/ Principal HCS, SMEs, Commissioner, Consultation Groups, these changes
prompt the creation of a new draft version.

The Lead Author is responsible for keeping the 'Revision History' table of the 'Document
Control Sheet' updated, including amendments made to each draft based on feedback from
the Lead/Principal HCS, SMEs, Commissioner, and Consultation groups, clearly indicating
the required changes.

Note: All draft reviews must be performed using tracked changes. When the document
undergoes review by the Lead/ Principal HCS or SMEs, the version with tracked changes is
kept as the original draft version — this is the version sent to them. If amendments are
necessary, a new document is created under the subsequent draft version number to
address these changes.

Every document, when first published (formally approved), will be assigned version V01.0
(Final). After an unscheduled review or minor amendment, the version will be updated to
V01.1 (Final). In the case of a scheduled review such as updating the literature review or a
major revision, the document will first be labelled VO1.1 (Draft) and, once completed and
approved, will become V02.0 (Final). Amendments to previous versions, whether draft or
final, should be recorded in the 'Revision History' table of the 'Document Control Sheet’.
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2.17. Under no circumstances should a version number be missed or re-used.

2.18. Tables 2.2 and 2.3 clarify the version numbering system and provide an example of how to
report the Revision History of the Document Control Sheet, respectively.

Table 2.2 — Version numbering system

Version Document state Example Document Name

V00.1 (Draft) | First draft Mass Timber Protocol V00.1
(Final).docx

V00.2 (Draft) | Second Draft - subsequent Mass Timber Protocol V00.2
drafts will employ sequential (Final).docx

numbers after the decimal
point (V00.3, V00.4, etc)

V01.0 (Final) | Published version Mass Timber Protocol V01.0
(Final).docx

VO01.1 (Draft) | Revision - Draft. Subsequent Mass Timber Protocol V01.1
drafts will employ sequential (Draft).docx

numbers after the decimal
point (V01.2, V01.3, etc.)
VO01.1 (Final) | Approved the revision with no | Mass Timber Protocol VO1.1
substantive change to content | (Final).docx

or procedure — It changes from
Draft to Final despites the
version number remains to
VO1.1.

V02.0 (Final) | Approved the revision with Mass Timber Protocol V02.0
mayor changes — It became a | (Final).docx

new version. Subsequent
major revisions will use
sequential numbering before
the decimal point (V03.0,
V04.0)

Table 2.3 — Example of reporting the Revision History of the Document Control Sheet.
VERSION DATE SUMMARY OF CHANGES NAME

V00.1 (Draft) | 20 05 2024 | Initial draft completed. Michael Sheers
(Lead Author) &
Mario Sogabe
(Supporting
Author)
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VERSION DATE SUMMARY OF CHANGES NAME

V00.2 (Draft) | 23 05 2024 | Update search terms as suggested by | Michael Sheers

the Principal HCS. (Lead Author)
V00.3 (Draft) | 27 05 2024 | Made minor changes related to Michael Sheers
formatting and typographical (Lead Author)

corrections based on SME feedback.
Document finalised for approval for
consultation stage.

V01.0 (Final) Revised review question based on Michael Sheers
consultation feedback. Finalised the (Lead Author)
document for publication.

Record Keeping

Folder Structure

2.19. The Lead Author is responsible for creating the following folder structure for the literature
review:

e Administration
o Correspondence
o Documents
e EndNote
e Project Stage
o Protocol
= SME Documents
o Search
= Database export
o Screen, Extraction, Appraisal
= References
e Exclude
e Include
o Write up

Correspondence

2.20. For the literature reviews, it is necessary to retain certain correspondence with SMEs and
the consultations. The specific correspondence that must be kept will be outlined in the
relevant section of this SOP.
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2.21. When saving the correspondence, the titles should always include the date, followed by the
name of the correspondent, along with the subject description. When using personal names
in file titles, list the surname in capitals, followed by the first name in title case (e.g.,
BLOGGS Joe). For example:

2023-09-04 BLOGGS Joe to HCS Technical Team — Report Sing-off.

Standardised Templates and Forms

2.22. To facilitate the review process, standardised template emails have been produced and are
available at Literature Review Templates. These templates can be modified as needed and
may be used solely for reference. The files are ‘locked’ from editing, meaning they must be
copied to a new location before any changes can be made

3. Review Process

(Add diagram with the main stages of the process here)
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4.1.

4.2.

4.3.

4.4.

4.5.

4.6.

4.7.

4.8.

SOP Literature Reviews

4. Review Initiation

Issue Gathering Information Form

The Lead Author allocated to the review is responsible for sending the 'Information
Gathering Form’ to the Commissioner or SME allocated to the review. The information
provided in this form will be used to conduct a preliminary search and develop the protocol.

There is a two-week timeframe for the Commissioner to complete the ‘Information
Gathering Form’. If it is not received by then, a follow-up email should be issued.

Once received, the Lead Author should acknowledge its receipt and arrange an initiation
meeting for further discussion using the ‘Initiation Meeting Invite’ email template.

Note: When a new review falls outside the Annual Work Plan, it is the responsibility of the
Lead/ Principal HCS to register the review in the NHSS Assure Commissioning System.

Initiation Meeting

Before the Meeting

This meeting should be arranged for the earliest date the SMEs have availability. It should
be attended by the Commissioner/ SME involved in the review, the Supporting Author, and
if available, the Lead/ Principal HCS.

Before the meeting, the Lead Author and, ideally, the Supporting Author should begin
familiarising themselves with the topic based on the completed ‘Information Gathering
Form’. This can be achieved through an initial search, which should be broad and informal,
using platforms such as the knowledge Network, Web of Science, Google/ Google Scholar,
and/or any sources provided by the Commissioner/ SME. Gaining this background
knowledge will enable any clarifying questions to be addressed during the meeting.

During the Meeting

The Lead Author is responsible for facilitating the initiation meeting.
In this meeting, the following should be addressed:
e The authors should gain a clear understanding of the ask and the scope of the review.

e Emphasise the importance of SME input and timely contributions to ensure the review is
delivered within the agreed timescales and meets high-quality standards.

e Agree on update meetings, aiming for every two weeks, with the flexibility for this to
change throughout the review.

e OQOutline the SME responsibility to introduce the HCS team to the consultation group.
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e Inquire whether any member of the consultation group has affiliations outside of
NHS/UK Government bodies, such as universities or private consulting firms. If so, a
conflict-of-interest form should be sent, signed, and returned, declaring any potential
conflicts.

Note: While the primary purpose of the initial search is for the authors to familiarise
themselves with the topic, it may occasionally reveal limited evidence. If this occurs, it
should be brought to the attention of the Commissioner/SME during this meeting, and
discussions should take place on whether the review scope or suggested questions need
adjustment. If it is decided that the review scope will remain unchanged, a follow-up

of the available evidence and ensure that the decision to whether proceed or not with the
review is based on a comprehensive assessment.

Follow up the Meeting

After the meeting, the Lead Author should proceed with the following:

e Send a follow up email to the SMESs using the ‘Initiation Meeting Follow-up template,
including the meeting notes, next steps, and reiterating the importance of introducing the
HCS team to the consultation group. If required, a link to the Conflict-of-Interest form
should be provided. The signed forms should be saved in the folder
[ReviewName]>Administration> Correspondence.

e Set up arecurring meeting for updates at the agreed times.

e Email the Research Service Review Management Team with the following information
related to the review: Review name, Review type (systematic, scoping or rapid review),
Lead Author and Supporting Author(s) names, SME(s) involved, consultation group, and
project start date.

5. Protocol Development

Preliminary Search

A preliminary search should be conducted to support drafting the protocol. Unlike the initial
search, this search is more systematic and focused, building on the initial findings but with
greater rigor.

The Lead Author is responsible for conducting the search using broad terms, including
those listed in the ‘Information Gathering Form’ and identified during the initial search.
General databases such as Scopus (Core Collection), Web of Science, and other topic-
specific databases should be used. A list of recommended databases can be found in
Section 10 of the SOP Literature Review Protocol.
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The number and types of relevant reports identified should be recorded. Titles and
abstracts should be skimmed to identify key themes, methodologies, and gaps in the
literature. This information will be also essential for refining the review questions and
inclusion/ exclusion criteria.

Common keywords and subject headings that are identified during this search should be
noted and included in the search terms table of the Protocol (Section 12).

The Lead Author is responsible for checking the repository platforms for literature reviews
such as PROSPERO and Open Science Framework to confirm whether the review has
been or it is currently being conducted. This step is important for avoiding duplication of
efforts and ensuring the originality of the review. Similar reviews should be noted to refer
back to.

At the end of the search, the Lead Author should be able to:

e confirm whether there is enough relevant evidence to support a systematic review or
scoping review;

e decide whether to proceed with the review based on a more detailed understanding of
the existing evidence; and,

e provided an informed estimate of the required resources and timescale for completing
the review.

Completion of Protocol

The Lead Author is responsible for drafting the protocol using the Protocol Template and
adhering to the SOP for protocol development. The Supporting Author is expected to
provide some input or, at a minimum, review the document.

For updates to existing literature reviews, the author(s) should review the existing question
set and ‘Implications for Further Research’ section to determine if amendments are
required. The author(s) should re-assess the existing search strategy to ensure it aligns
with the review questions. If any significant amendments are required, then it should be
taken to the Lead/ Principal HCS for a decision on whether a new review is more
appropriate.

The search should be limited to the date since the last update.

Once the protocol is produced and both authors are content with it, it should be sent to the
Lead/ Principal HCS for a sense check with the ‘Track Changes’ feature enabled. If they are
unavailable, an Advanced HCS can perform this task. The Lead Author should incorporate
and respond to any comments provided. If amendments are required, a new draft version of
the protocol should be produced.
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The draft protocol will then be emailed to the SMEs for their feedback, also with the “Track
Changes’ feature enabled. The ‘Protocol for SME feedback’ template should be used to
write the email.

The SME has six working days to provide their feedback. The Lead Author is responsible
for integrating this feedback into a new draft version of the protocol.

A meeting needs to be organised to discuss the feedback with the SMEs or it can be
addressed during one of the recurring meetings with extended duration. When possible, the
updated version of the protocol, with the amendments incorporated, should be emailed to
the SME a few days prior the meeting. The body of the email should outline the
amendments and highlight any potential discussion points to cover in the meeting.

After the meeting, once all the amendments have been addressed, the Lead Author should
send the ‘Protocol approval for consultation’ email to the SME. The email should outline the
changes made to the protocol based on the meeting discussion and seek the SME's
approval before proceeding to the consultation stage. If the Commissioner is different from
the appointed SME, the Commissioner should be cc’'d in the email. The SME has five
working days to complete this task.

Note: At this stage, an estimate for the completion of the review can be provided. However,
a more accurate timeline can be established following the second screening, once the
volume of reports requiring critical appraisal and data extraction is known. The file [Year-
Year] HCS Tech Review Timeline’ can be used to support the development of these
timescale estimates.

Protocol Consultation

The Lead Author is responsible for drafting an Evaluation Tool for the consultation.

Only for consultation purposes, a new document should be created, including the following
sections from the protocol: review background and aim, review questions, search terms,
and inclusion/exclusion criteria. The document should be named ‘[Review Name] Protocol
Consultation’ and saved in the folder: [ReviewName]>Project Stage>Protocol.

This document, along with the Evaluation Tool, should be sent to the Information Officer to

Consultation Group using the ‘Protocol Consultation’ email template. There is two-week
consultation period.

Reminders should be sent one week and two days before the deadline. It is important to
adjust the consultation timeline accordingly if it coincides with holiday periods, and in
agreement with the SME and Lead/ Principal HCS.

Following consultation, the Lead Author should compile any comments received using the
‘RN Consultation’ template and name the document ‘RN Comments and Responses
Protocol Consultation’. Discuss the comments with the SMEs and draft responses together.

Month 2024 V00.5 (Draft) Page 17 of 61



5.21.

5.22.

5.23.

5.24.

5.25.

5.26.

5.27.

5.28.

5.29.

5.30.

SOP Literature Reviews

If amendments to the protocol are agreed upon, the draft version must be updated, and the
amendments should be recorded in the ‘Summary of Changes’ section of the ‘Document
Control Sheet.’

The ‘Final Protocol Approval’ email template should be used to obtain final sign-off of the
protocol by the allocated SME, given them five days deadline for their response. If the
Commissioner is different from the appointed SME, the Commissioner should be cc’d in the
email.

Once approval is received, the draft version of the protocol becomes the final version (e.g.
V01.0 (Final)).

The ‘RN Comments and Responses Protocol Consultation’ document, along with the final
version of the protocol, should be sent the consultation group members. These document
and all related consultation correspondence are saved in the review folder titled [Review
Name]>Administration>Correspondence.

Deviations from Protocol

Deviations from the protocol during the screening and data extraction phases can be
expected. However, for systematic literature reviews, significant changes are not allowed. If
significant changes are necessary, a new version of the protocol must be produced.

Permissible changes in systematic literature reviews include adjustments to data extraction
and synthesis processes, or changes to the reviewers involved in the literature review, but
not substantial alterations to any elements of the review question. If there is any
uncertainty, this should be consulted with the Lead/Principal HCS.

Amendments to the protocol need to be communicated and agreed upon with SME. An
email should be sent clearly outlining the amendments made to the protocol, providing
justification for each change, and requesting their confirmation of agreement with these
alterations. This email should be stored with approval in the folder [Review
Name]>Administration>Correspondence.

All amendments should be made on the initial version of the protocol, using tracked
changes without accepting them. Once the amendments are completed, this version (e.g.,

are then accepted.

When making amendments to the approved protocol version, if the changes are minor, it
should be renamed to V01.1 (Final). For significant changes, a new version (V02.0 Final)
should be produced. Regardless of the extent of modifications, the approval details must be
updated in the ‘Document Control Sheet'.

Additionally, the Revision History must be updated, including a detailed summary of all
amendments from the previous approved version of the protocol. In the final report, any
amendments to the protocol should be clearly indicated in the first part of the methods
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section. If the protocol has been registered in a platform (refer to section X), this should be
also amended.

Protocol Registration

After approval of the search strategy, the protocol must be registered in an open-access
repository for literature reviews. Registration must be completed before initiating the search.

For systematic and rapid literature reviews not involving human subjects, as well as scoping
reviews, the protocol should be registered in the Open Science Framework (OSF). The
‘Generalised Systematic Review’ OSF template must be completed, and guidance can be
found at https://help.osf.io/article/229-select-a-reqgistration-template.

For systematic and rapid reviews involving human subjects, the protocol must be registered
in Prospero. All documentation related to Prospero registration is available at PROSPERO

(york.ac.uk)

6. Search

Search Strategy

The Lead Author should develop a search strategy using the search terms indicated in the
protocol and for each database specified.

The databases are accessible through the Knowledge Network. If a database is not
available, the Librarian at Public Health Scotland (PHS)? can assist in developing and
running the search strategy.

Before start working on the search strategy, the Lead Author should contact the Librarian at
PHS to confirm their availability to assist in reviewing and/ or formulating the search
strategies.

In some instances, the Lead Author can create a search strategy for one database and the
Librarian can adapt it to the other databases specified in the protocol. However, this should
be done in consultation with the Librarian to ensure they have the resources. If resources
are available, the Lead Author can create a search strategy for one database and send it to
the Librarian, who will review and adapt it to the other databases. Should this not be
feasible, the Lead Author is responsible for formulating the search strategies for all
databases and sending them to the Librarian for review.

2 phs.knowledge@phs.scot
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When sending the search strategy to the Librarian, only the review questions,
inclusion/exclusion criteria, and the list of search terms should be provided, rather than all
the details from the protocol.

When developing the search strategy, consistency in the application of search terms across
all databases should be ensured. A guide on creating search strategies for various
databases is provided in the document X.

Either the Lead Author or Supporting Author can develop the search strategies for the grey
literature.

All search strategies should be documented in one Word document using the ‘2024 Search
Strategy Template.docx'. This document should be titled ‘[Year] [Review Name] Search
Strategy' and saved in the folder "[Review Name]> Project Stage>Search

The developed search strategy(ies) should be shared with the Supporting Author for
feedback and subsequent review by the Lead/ Principal HCS before being forwarded to the
Librarian. The Lead Author is expected to integrate any necessary feedback.

The initial draft shared with the Lead/ Principal HCS should be the first version draft. If
amendments are necessary, this should be updated to version draft 2. Following this, the
search strategies should be sent to the Librarian.

If any questions related to Librarian feedback, then they should be contacted for
clarification.

The Search Strategies Document from the Librarian should be kept for our records in the
folder’ [Review Name]> Project Stage>Search. Thid document should be nhamed ‘[Date]
[Review Name] Search Strategy Librarian Peer-Reviewed’.

The Lead Author should incorporate the Librarian's feedback in the document ‘[Year]
[Review Name] Search Strategy' and report a summary of the amendments to the search
strategies developed by the librarian in the ‘Revision History’ table.

The Lead/Principal HCS must sign off the final version of the Search Strategy.

Running the Search

Either the Lead Author or Supporting Author can search the databases. When there is not
access to a database, the Librarian may be able to run the search.

When the search is run in a database, all the results should be exported using the format
‘EndNote’ and the completed reference.

When exporting the search from the database, the file should be saved in the folder
‘[ProjectName]>Project Stage>Search>Database export’. The file name should follow the
format: Date Executed (YYYY-MM-DD) [ProjectName], [Database] (such as, ‘2024-01-31
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Mass Timber, Scopus’). Some databases only allowed a certain number of records to be
saved, in this instance the files must be numbered sequentially when saving.

A copy of the searches, with the number of hits associated with each search line and the
links to the search, should also be exported to Word for record-keeping using the file
created earlier ‘[Year] [Review Name] Search Strategy’. This should include the date
executed, entire search, link to access the search on each database, the recording of
results and limits placed on the search.

Import Database Searches to EndNote

Once the searches are conducted, the Lead Author is responsible for exporting the search
results to EndNote. To do this, a new EndNote Library should first be created for the
specific review, using the EndNote template located in the “Template’ folder. Name the file
‘[ProjectName] EndNote Library’ (e.g., Mass Timber EndNote Library) and save it to the
folder [ProjectName]>Endnote.

Note: When working on multiple reviews, it should always be ensured that the correct
EndNote library is open so that files are imported into the appropriate library.

Before importing any files, a name for each database searched (e.g., Embase, Scopus)
should be created under ‘Databases’. A number can be added after the database name to
indicate the number of references obtained from that specific database. For example,
Medline (37), where 37 represents the number of references from that database before
deduplication. This information will be used to complete the PRISMA flow diagram.
Although this number will also be recorded in the [ProjectName] Search Strategy’
document, it serves as an additional check to ensure the numbers are accurate.
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Each search should be imported one at a time, starting with high-quality sources such as
Ovid Databases. This is because EndNote, by default, sends the most recently added
records identified as duplicates to the ‘Trash’, retaining those added first. The preferred
order of databases, which can be adjusted as necessary, begins with Ovid databases such
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as MEDLINE, followed by other reputable sources like CINAHL, Web of Science, and
Scopus.

When a search is imported, it will always appear in the ‘Imported References’ folder. All
records should be selected (press Ctrl + A) and moved to their associated folder — e.g., if
the search imported is from Scopus, move the records into the Scopus folder. Add the
number of references to the name of the group, such as Scopus (56).

Deduplicate in EndNote

After all searches have been imported into EndNote, deduplication should be performed,
beginning with automatic deduplication followed by a manual check. Any duplicate records
that are missed during this process can be identified during the screening stage.

Automatic Deduplication

To perform automatic deduplication in EndNote, the following steps should be followed:

e First, go to 'Edit > Preferences'. In the dialogue box, select 'Duplicates' from the left-
hand menu. For the first deduplication, ensure the boxes for 'author’, 'year', 'title’,
‘journal’, 'volume', 'issue’, and 'pages’ are ticked.

e To proceed with deduplication, make sure ‘All References’ are displayed on the
EndNote screen. Go to ‘Library > Find Duplicates’. Instead of reviewing each duplicate
individually, close the ‘Find Duplicates’ dialogue box. This action will automatically
highlight all duplicates in grey. Then press ‘Delete’ or right-click and choose ‘Move
references to Trash’.

e To ensure all duplicates are removed, perform the deduplication process multiple times
using various combinations of reference fields. To do this, navigate again to ‘Edit >
Preferences’. In the dialogue box, select ‘Duplicates’ from left hand menu. Try using
different combinations at the time to ensure thorough deduplication. For example:
‘author, year and title’; ‘author and title’; ‘title and year’. When using these combinations,
review each duplicate individually instead of selecting all. This will prevent accidentally
deleting non-duplicate references. When all duplicates are highlighted, if a reference is
identified that is not a duplicate, hold down the control key and click to unhighlight it
while keeping the others highlighted. Delete all duplicate references or move them
manually to the trash.

Note: Even when records are deleted, the reference numbers (ID) remain unchanged, as
they are unique to each reference, whether deleted or not. However, the number of results
in each database group may no longer match the original numbers.

Manual Deduplication

EndNote's automatic deduplication relies on references having similar fields, including
consistent formatting and capitalisation. Variations in data entry, such as differences in
author names or journal titles, can cause duplicates to be missed during automatic
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deduplication. To ensure all duplicates are removed, a manual check should be performed
by reviewing the entire reference list. Ensure that "All References" is selected and the list is
organised alphabetically by title or author. When a duplicate is identified, the reference with
the higher record number should be deleted.

At this stage, the total number of deduplicated references — those in the Trash folder —
should be recorded and entered in the PRISMA diagram under ‘Duplicate records
removed’. Additionally, the remaining references after deduplication should be noted under
‘Records screened’.

When reviewing the list of references, some records may be missing the title, abstract, or
publication year. In such cases, the original source can be accessed via the URL link, and
the missing details should be manually copied and pasted by selecting the 'edit' option in
the record. For editorials, commentaries, or similar types that often lack abstracts, a
comment such as 'editorial letter' or ‘commentary' should be added in the abstract field.

Export from EndNote to Excel

Following deduplication, references from EndNote should be exported to an Excel
spreadsheet.

Steps for First-Time EndNote Users

When using EndNote for the first time, the Output Style ‘Excel Import (standard)’ needs to
be added, located in the ‘Template’ folder. Double-click the file, and it will automatically
open in EndNote. Once open, go to ‘File’ and select ‘Save As’. Remove the word ‘copy’
from the file name and click ‘Save’. Then, go to ‘File’ again and select ‘Close Style’. The
style will now be added to your EndNote styles.

Additionally, the ‘Excel Import (standard)’ needs to be included in the ‘Output Styles’ list. To
do this, navigate to ‘“Tools > Output Styles > Open Style Manager’. Find ‘Excel Import
(standard)’, tick the box, and close the window. This style should now be listed in the
‘Output Styles’. This process can be repeated for any other output style wished to be
added. For example, when preparing a publication for a specific journal, the referencing
style used by the journal can be located in the ‘Style Manager’ (located under ‘Output
Styles') or added manually. Having these ‘Output Styles’ are important for integrating
references into the final report or journal article.

Useful to Know

How to Modify ‘Excel Import (standard)’

The ‘Excel Import (standard)’ style is designed to export Record Number, Journal, Author(s),
Publication Year, Title and Abstract (in that order) from EndNote.
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If additional categories are required — such as in a scoping review where more detailed data is

the time of the request. This discussion is essential because the Excel Review Tool, covered in the
next section, is currently set up to import only six columns (categories). If more or fewer than six

impact the formulas.

If the request can be accommodated, the following steps should be followed: Navigate to ‘Tools >

field from the list. A tab needs to be included between fields. Select ‘Insert Field’ > ‘Tab’ to include a
tab. To save the new output style, go to ‘File > Save As’ and name it ‘Excel Import ([additions
made])’. This template should be added to ‘Template’ folder, so it is accessible for future reviews
that require similar extractions.

Steps for Exporting EndNote Results to an Excel Spreadsheet

To export EndNote results to Excel, it is important to ensure that ‘Excel Import (standard)’ is
selected in the ‘Output style’.

To begin the export, first save the EndNote file as a copy, naming it [ReviewName]
EndNote Library Copy’, and store it in the same folder. Once this is done, close the original
EndNote file and open the copy.

In the copy, navigate to ‘Library > Find and Replace’. In the dialog box, change ‘select a
field’ to ‘any field’ and change ‘insert special’ to ‘carriage return’. In the ‘replace with’ box,
type ‘/’. Click ‘change’ and then ‘OK’.

Next, under ‘Edit’, select ‘Select All’', then navigate to ‘Tools’ > ‘Output Styles’ and choose
‘Excel Import (standard)’. Afterward, go to ‘File’ > ‘Export’ and click ‘Save’. The file will be
saved with the .txt extension in the folder [ReviewName]>Endnote and should be named

‘[ReviewName] EndNote Library Copy.txt'.

This file should now be opened in Excel. To do this, open up Excel and select '‘Open'.
Browse to the EndNote project folder and select the file. To be able to see it, ensure that 'All
Files' is selected.

The Import Wizard will then open; click 'Next' twice and then 'Finish'. This will populate the
columns. The file should be saved as ‘[ReviewName] EndNote to Excel’ and saved to the
folder [ReviewName]>Endnote. Ensure the file is saved with the extension .xIsx.
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7. Study Selection

Review Tool

For each new literature review, an Excel Review Tool needs to be created. A template is
available at Literature Review Templates named ‘2024 Excel Masterfile (marcos).xlsm’. The
template should be opened and saved as a copy to the folder [ReviewName]>Review
Stage>Screen, Extraction, Appraisal, with the name [YEAR] [ReviewName] Review Tool'.
Macros should be enabled in the file when first opened, if prompted.

The Excel Review Tool contains several sheets, each of which will be explained in the
following sections. The '1. Database Screening' sheet includes various column filters to
support the automated screening process. If any issues arise when using these filters,
assistance from the team should be sought. If the team is unavailable, the process may be
completed manually.

Copying Data Imported to Excel to the Review Tool

The .xlIsx. file saved with the data imported from EndNote to Excel (‘{ReviewName]
EndNote to Excel’) should be copied into the new project Review Tool. To do this the
following steps should be followed:

e Open the file [ReviewName] EndNote to Excel’.

e Click on cell A1 to place the cursor there, then press ‘Ctrl + A’ to highlight all the cells
with data.

e Once highlighted, press ‘Ctrl + C’ to copy the data.

e Open the [ReviewName] Review Tool’ and navigate to the ‘1. Database Screening’
sheet.

e Click on cell A3, then press ‘Ctrl + Alt + V'. In the ‘Paste Special’ dialogue box, select
‘Values’ and click ‘OK’ or press Enter. This will paste the data while retaining the
formatting.

e |If the formatting is not retained, select the text and use the “Top Align’, ‘Left Align’, and
‘Wrap Text’ options in the ‘Alignment’ section of the ‘Home’ ribbon to make the text
visible. If any issues occur, use the backspace arrow or press ‘Ctrl + Z’ to undo and try
again.

Screening

There are two screening stages: the first screening and the second screening. The initial
screening of the records is based on their titles and abstracts. Those that pass this stage
move on to the second screening, which involves a decision based on the full text.
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Note: The ‘1. Database Screening’ sheet of the Excel Review Tool is designed for literature
reviews involving two authors. If the screening is only conducted by one reviewer, then the
columns related to the second reviewer should be hidden. It is not advisable to delete the
second reviewer and consensus columns because if resources become available the
review could transition easily to a two-author review once it has commenced.

When the review is conducted by two authors, they should be blind to each other’s
decisions. This can be achieved by selecting either:

e the purple button labelled “1st Reviewer’, which will hide the 2nd author inputs and
consensus columns; or,

e the green button labelled ‘2nd Reviewer’, which will hide the 1st author inputs and
consensus columns.

Hiding columns can be also done manually by clicking on the letter(s) at the top of the
column wanted to hide and pressing ‘Ctrl + 0’ (zero). This will hide all the selected columns
at once. Hidden columns can be recognised by the appearance of a narrower gap or a
double line where the column letters skip.

To unhide the 1st or 2nd Reviewer columns automatically, press the button labelled ‘Clear
Filters’. If an error occurs, make sure to click on a cell within the table — starting from Cell
Al. Clicking outside the table may cause the automation buttons to not recognise the table
and thus be unable to perform the action. Unhiding columns can be also done manually.

Useful to Know

How to hide cells when working on the same Excel Review Tool simultaneously

At times, two authors might work on the same file simultaneously and need to apply some filters. To
avoid affecting each other's views with filters and hidden cells, follow these steps:

e On the top ribbon, select 'View.'

¢ In the “sheet view” box that appears, choose 'Default,’ then select the relevant view from the
drop-down list: '1st Reviewer,' '2nd Reviewer,' or '3rd Reviewer.'

e To exit this view, switch back to 'Default.’

Note: This method prevents filters and hidden cells from impacting other reviewers' views. All cell
edits, such as adding information, will still be visible in all views. These views are only set up in the
sheet ‘1. Database Screening’ and ‘2. Other Methods Screening’.

If you wish to bring someone’s attention to a particular cell or highlight a potential error, you can
right click that cell and select ‘comment’ and tag the person with the comment.

Identifying Duplicates During the Screening Stage

Even if deduplication was performed in EndNote, duplicates can sometimes still be
identified during the screening stage.
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For two reviewers, the approach to identifying duplicates should be as follows: the first
instance of the duplicate should be screened as usual, marking it as 'Y", 'N', or 'U'.
Subsequent duplicates (lower rows in Excel) should be marked as 'D'. This ensures both
reviewers consistently identify the same record as a duplicate, resulting in 'DD'.

Occasionally, only one reviewer might identify the duplicate, resulting in combinations such
as 'YD' or 'DY". This discrepancy must be verified, and reviewer’s entry must be changed to
'D'. Therefore, in the consensus column it will appear as ‘DD’.

If duplicates are encountered, they must be deleted from both the EndNote Library and the
Excel Review Tool. Ensure the PRISMA diagram, both ‘Duplicate records removed’ and
‘Records screened’, are updated accordingly.

First screening

The first screening of the records is based on their titles and abstracts. If conducted by two
authors, each should record their decisions in the 1st screening column, using the following
labels: Y (Pass screening/ Included), N (Fail screening/ Excluded), U (Unsure), and D
(Duplicate).

A notes column is available for each reviewer to note any observations that might be helpful
during the consensus meeting.

Once both reviewers have completed the first screening, the “1st Screening Consensus’
column in the Excel spreadsheet will display all the results from the screening process:

e Agreements are indicated in the consensus column as:
o ‘YY’ and ‘NN’: Both reviewers agree to include or exclude the record.
e Disagreements are indicated in the consensus column as:

o ‘YN or ‘NY’: One reviewer decides to include the record while the other decides
to exclude it.

o ‘YU, ‘NU’, ‘UY’: One reviewer is uncertain (‘U’) while the other provides a
definitive answer (either Y’ or ‘N’).

e Uncertainty by both reviewers:

o This is indicated in the consensus column as ‘UU’.

In the case of disagreement, the reviewers must make a final decision on whether to
include or exclude the record. Once decided, the consensus should be updated to ‘Y’ or ‘N’.

If the reviewers cannot reach a decision, "U" should be used to flag the record for review by
a third party. Notes should be added to help the third party understand the disagreement.
The "U" will then be replaced with “Y* or ‘N*, indicating that the third party resolved the
disagreement.
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Uncertainty by both reviewers is considered as neither an agreement nor disagreement and
it is indicated in the consensus column as ‘UU’. In this case, a third reviewer will assess the
record and provide a definitive decision. The ‘UU’ in the consensus column should then be
replaced with ‘'Y** or ‘N**', indicating resolution by a third party following the uncertainty of
both reviewers.

During the consensus meeting, each disagreement should be reviewed and changed to
either pass (included) or fail (excluded) based on the consensus decision.

The automatised button <5 (red thumbs down button) on top of the ‘15t Screening
Consensus’ column, automatically identifies all disagreements, ‘UU’ entries, and duplicates.
To do it manually, scroll down the filter of the column ‘15t screening consensus’ and tick all
combinations, except YY’ and ‘NN’.

Once the process is finalised, there should only be the following combinations:
e ‘YY’ and ‘NN’: indicates initial agreement.

e ‘Y’ and ‘N’: Indicates agreement through consensus.
e Y*, N¥™: Indicates third reviewer took a decision when the reviewers disagreed.

e Y* N**:Indicates third reviewer took a decision when the reviewers where both
uncertain ‘UU’.

e ‘DD’: Duplicates

At the end of the first screening consensus, when pressing the button N (red thumbs down
button) nothing should appear. This indicates that all disagreements have been resolved.

It is essential to maintain a clear record of all initial screening choices by each reviewer and
consensus decisions. The results will be included in the final methods section of the report.
Below is an example of the text to be included in the report:

‘During the initial screening, agreement was reached on 70% of the records, while 20%
showed disagreement. Of these discrepancies, 18% were resolved through a consensus
meeting between both reviewers, and 2% required a final decision from a third reviewer. In
10% of the records, both reviewers were uncertain, and the final decision was made by a
third reviewer.’

To obtain the necessary results and calculations for the report without manual effort, go to
the Review Tool sheet ‘A. PRISMA Data’, and click the 'Refresh all data' button to update
the tables. The first two tables are dedicated to the 15 screening.

Include in the PRISMA flow diagram the number of records that pass the first screening.

Before moving on to the next stage, in the 1st screening consensus column, only the
studies that passed the initial screening should be ticked ('YY,"'Y,", 'Y* and Y**).
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Reports Retrieval

Retrieval of reports can be performed by either the Lead Author and/or the Supporting
Author. The responsible person should not start the second screening process until all
reports have been retrieved, except for those still awaited from the Library.

Reports can be accessed through resources like Google Scholar, the National Library of
Scotland, or The Knowledge Network. For convenience, the Excel Review Tool includes a
'‘Google Scholar Search' column that provides links to the reports in Google Scholar.
However, as this is an automated method that only searches by title, due diligence should
be taken to ensure it is the correct report.

The browser extension LibKey Nomad can also be used to access all reports available
through the Knowledge Network by accessing them directly through publisher websites or
via search engines. Instructions on how to install this extension are provided in the link.

In the Excel spreadsheet's retrieval column, mark 'Y" if the report has been retrieved, or 'R' if
the report has not been retrieved and needs to be requested.

For those reports that have been retrieved, download the pdf and save them within the
folder [ReviewName]>Review Stage>Screen, Extraction, Appraisal>References. Name the
record as follows:

e For a single author, use the EndNote reference number, author's surname, and year
(such as, Ref504 Nicol 2008).

e For two authors, use both surnames and the year (such as, Ref21 Nicol and Kinloch
2020).

e For more than two authors, use the first author's surname followed by ‘et al.' and the
year (such as, Refl123 Labajos et al. 2006).

If no pdf is available but a webpage is accessible, a pdf can be created by right clicking on
the webpage and selecting print to pdf. The pdf should be saved using the naming indicated
above. It is important to check that the website has been converted correctly to pdf.

All the reports that have not been retrieved should be requested from the library providing
the full list at once. To produce this list automatically, go to 'A. PRISMA Data' sheet and
press the orange button ‘Refresh Data’. In the table labelled 'Record Retrieval', double click
on the number cell next to the ‘R’. This will open another sheet containing all the records
that need to be retrieved. Keep only the first six columns (A-F) and delete the other
columns, as they are not relevant for the Librarian.

If a report cannot be retrieved by the Librarian, mark it as ‘N’ in the retrieval column. For
reports successfully retrieved by the Librarian, update the status to ‘Y’. By the end of this
stage, the cells in the retrieval column should only display Y’ or ‘N’.

In the PRISMA flow diagram, the number of studies that have not been retrieved should be
indicated.
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Before proceeding to the next stage, ensure that the ‘Report Retrieval’ column displays only
the records that have been retrieved (marked as ‘Y’).

Second Screening

Decisions for the second screening should be made based on the full text. Each reviewer
must document their decision in their respective 2nd screening column, using the same
labels as in the 1st screening: Y (Pass screening/ Inclusion), N (Fail screening/ Exclusion),
U (Unsure), and D (Duplicate).

When conducting the 2" screening, when a record is excluded, a reason for exclusion
needs to be provided. For the system to allow the reason to be entered in the cell, if this is
the first time the exclusion reason is used, it must first be added to the 'Exclusion List' table
in the ‘A. List’ sheet. This will then automatically appear in the drop-down list under each
cell in the ‘Exclusion’ column. The filter ‘Go to Exclusion List’ will take directly to that sheet.
Additionally, there is a ‘Spell Check’ button to check there are not spelling mistakes.

When conducting the second screening each reviewer should identify the type of study
design. This will automatically appear in the drop-down list under each cell of the ‘Study
Design’ column. If the study design does not appear in the dropdown list, this has to be
brought to the attention of the HCS team for discussion.

From this point, the same stages as outlined in the first screening should be followed. For
those reports that are excluded, there should be an agreement on the exclusion reason, if
different between reviewers.

Reports that do not pass the second screening should be moved to the ‘Exclude’ folder,
while those that pass should be moved to the ‘Include’ folder, located in the folder
[ReviewName]>Review Stage>Screen, Extraction, Appraisal>References.

The ‘A. PRISMA Data’ sheet can be used to populate the PRISMA flow diagram with the
number of records that were included and excluded after the 2" screening and report the
reason for exclusion.

Citation Search

Some reports may not be captured through database searches alone, making it important to
conduct citation searches, both backward and forward.

Backward citation — During the second screening, data extraction, or when reviewing
available literature reviews related to the topic — e.g. systematic, narrative, etc — relevant
citations that were not captured in the initial database search may be found.

To ensure these citations are not overlooked, first verify if the citation identified is already in
the Excel Review Tool. If not, include the reference in the ‘Other Methods Screening’ tab.
Under the ‘Sources’ column, select ‘Citation Searching’ from the dropdown list and indicate
whether it is a peer-reviewed study, using yes or no under the column ‘Studies’.
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Manually add the reference to the EndNote Library under the ‘Citation Searching’ group to
allocate a reference ID.

Forward citation — Conduct a forward citation search for all the included reports. Tools like
Google Scholar can facilitate this process. Quickly scan to identify relevant reports that
were not retrieved through the initial database search. If these reports have not been
already screened, follow the same process as above.

Additionally, include reports identified through grey literature searches in this tab. In this
case, under the ‘Source’ column, indicate ‘Grey literature searching’.

All the reports in this tab need to undergo a second screening:
e For peer reviewed studies, the screening must be conducted by two reviewers, following
the same process as database screening.

e For grey literature, screening will be conducted by one review.
The reports that could not be retrieved should be requested from the Library.

Update the PRISMA flow diagram to reflect the number of reports identified through citation
searches and grey literature. These are reported under ‘Identification of studies via other
methods’. Document the number of reports not retrieved, those assessed for eligibility, and
those that did not pass the second screening (including reasons for exclusion). Add the
number of reports included through ‘other methods’ to the database number.

Useful to know

EndNote Unique ID and Review Tool Integration

There are various ways to add references to EndNote, either manually or automatically. To add a
reference, go to Google Scholar, Science Direct, or the publisher’'s website and click on the citation
option for EndNote. Ensure the EndNote library for the correct project is open, then double-click the
downloaded item or navigate to the ‘Download Folder’ on the PC. The reference will open in the
currently open EndNote library, or if none is open, it will open the last saved one. A unique
reference number will be allocated to this reference. Move the reference to the required group.

Grey Literature Search

If resources are limited, the librarian may conduct the grey literature search, provided they
have the capacity.

The time spent on grey literature should be limited to a maximum of three to five working
days, conducted by a single author, either the lead or Supporting Author, or both.

The grey literature search strategy should be documented in the Review Review Tool within
the sheet titled ‘A. Grey Literature Search’. The following has to be recorded: the name of
the source (e.g., Google Scholar, ‘CDC’) or organisation if the search was conducted
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directly, the date of the search, the search string (including the Boolean operators and exact
terms), the URL (preferably linked to the search but the website page if not), the number of
hits, relevant results, and any necessary notes should be recorded. If multiple searches
using different terms are conducted for a specific database, each should be documented
separately.

A review of the full-text report should be conducted at the time of searching grey literature.
For studies that are not peer-reviewed (treated them as grey literature), the title and
abstract should be reviewed, and if deemed relevant, the full text should be downloaded
and recorded in the sheet ‘2. Other References Screening’.

References included in the review through grey literature search should be included to
EndNote under the group ‘Grey literature searching’.

8. Critical Appraisal

The Lead Author is responsible for conducting the critical appraisal of the included reports.
The level of involvement of the Supporting Author depends on the type of review and the
agreement at the initiation stage.

It is recommended to complete the critical appraisal before going into comprehensive data
extraction. This approach ensures that reports with serious methodological concerns are
identified early, preventing the unnecessary effort on data collection from reports that may
not meet the inclusion criteria for methodological quality.

All reports, including empirical studies, expert opinion and grey literature, should be critically
appraised for methodological quality/risk of bias by the Lead Author using the checklists
and their respective guidance provided in the Critical Appraisal Checklists Document.

For mixed methods studies, the qualitative and quantitative parts are assessed and
reported separately.

Note: Currently, there are no available checklists for assessing the methodological quality
of experimental non-human studies. As a result, these studies cannot be evaluated for
methodological quality. However, they must still undergo assessment using the two initial

were not assessed for methodological quality.

Note: When guidance documents are identified that may potentially answer the review
guestion, or part of it, they should first be assessed using the AGREE tool. A full
assessment is not always necessary; a quick review can provide an indication of quality. If
the guidance appears to be of low quality at first glance, it should be immediately classified
as grey literature. However, if the quality is unclear, a full assessment should be conducted.
If the score is less than 60%, the guidance will be classified as grey literature and assessed
using the AACODS checklist.
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Mandatory or legislative documents are exempt from assessment.

MS Forms Setup

The critical appraisal process will be conducted using the MS Forms template accessible in
the Literature Review Templates folder, named ‘2024 PN Critical Appraisal Checklists
Template’. Alternatively, the orange button labelled ‘Complete Critical Appraisal (CA)’ in the
‘4. CA Tables’ sheet of the Review Tool can be used to access the form.

The MS Forms template is a non-editable copy to prevent it from being overwritten.
Therefore, once the template opens, the ‘Duplicate it’ button should be clicked. It is
essential to be signed in to MS 365 to access MS Forms. The duplicated form is named
‘Review Name Critical Appraisal Checklists (Copy).” The name should be changed to reflect
the title of the review and removing ‘(Copy)’. Once changed, the address bar should be
copied and assign the link to the button on 4.CA Appraisal Edit/View CA Response.

All forms are saved to the MS Forms Home page, accessible through MS 365 online. The
newly created form should be assigned to ‘HCS Tech’ to ensure full accessibility for all team
members. If the required form is not visible under ‘Recent,’” navigate to ‘My forms.” Hover
over the form, click the three dots and select ‘Move to a group,’ scroll down, choose ‘HCS
Tech,” and click ‘Move.’ If the form is being viewed under ‘My forms,’ it will disappear from
the list and will now be located under ‘My groups.’” To find it, scroll down on the page to ‘My
groups’ (it may be necessary to click ‘'show more’) and select ‘HCS Tech.’ All forms
associated with this group will be visible on this page.

A link to this new MS Form should be assigned in the Review Tool. To do this, click on the
‘Collect Responses’ button within the MS Form, then select ‘Copy link.’” In the ‘4. CA Tables’
sheet, right-click on the orange button labelled ‘Complete Critical Appraisal (CA),” select
‘Edit link,” paste the new link into the ‘Address’ bar and click ‘OK.’ This action will override
the current link. It is important to double-check that when clicking the ‘Complete Critical
Appraisal’ button, it directs to the correct form for completing the CAs.

Once this is done, the ‘Complete Critical Appraisal’ button should be clicked to ‘conduct the
critical appraisal for each report that passed the second screening.

The MS Form contains all the checklists needed for conducting the CAs. The study design
selected on the first page determines which checklist appears on the following page. If an
error is made when selecting the checklist, it is possible to scroll to the bottom of the
checklist and click ‘Back’ to select the correct checklist. It should be ensured that any
questions already completed on the incorrect checklist are deleted by using the ‘eraser’ icon
next to the question.

Note: Once a form is completed and submitted, the response cannot be edited. If an error
is noticed after submission, the response associated with the specific report can either be
deleted (i.e. the entire form) or edit the specific error once the response has been exported
to Excel.
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Critical Appraisal Procedure

At the start of the form, there are two screening questions. If the answer to either of these
screening questions is ‘No’ or ‘Unsure’, the appraisal will conclude, and the report will be
excluded. However, it is important that the relevant checklist is still selected. Do not answer
the checklist questions; instead, scroll to the bottom (or press ‘End’ on the keyboard) and
click ‘Submit.” This procedure ensures that even though the report failed the screening
guestions, the study design is still documented.

Although currently experimental non-human related studies currently do not have a
checklist, these studies must still go through the screening questions to minimise bias as
much as possible. This process helps determine if the study should be excluded based on
the screening criteria. Once the screening questions are answered, the survey will
automatically conclude.

For expert opinion and grey literature, the screening questions might not apply. In this case,
‘N/A’ should be selected.

Responses to checklist questions should be marked as ‘Y’ for Yes, ‘N’ for No, ‘U’ for
Unclear or Can't Tell, and 'N/A" for Not Applicable.

A comment box is provided at the end of each checklist for documenting justifications,
flagging items that require further discussion, or seeking additional information from the
study authors. It is important to include the checklist question number being referred to in
this box to ensure clarity when reviewing the comments later.

After completing each checklist, it is essential to click ‘Submit’ to ensure the response is
saved. If ‘Submit’ is not clicked, the next time the form is opened, it will display the last
checklist that was worked on. In such cases, clicking ‘Submit’ at that stage will save the
progress.

If there is uncertainty about how to answer certain questions or difficulty completing the

critical appraisal, support should be sought from other HCSs.

View and Delete Responses

To view and delete the responses, the orange button ‘Edit/View CA Responses’ should be
clicked, which will direct to the MS Forms responses.

To delete a response, click the ‘Edit/View CA Responses’ button, then select ‘Responses’,
and ‘View Results’. Use the arrows to navigate through the responses until the one to be
deleted is found, click the three dots, and select ‘Delete response.’

Note: If an error is noticed after the response have been exported to Excell, then the error
could be corrected in Excel — there is no need to delete the entire response.
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Exporting Responses to Excel

Once the critical appraisals have been completed, the responses should be exported to
excel. To do this:

¢ Click the ‘Edit/View CA Responses’ button, then select ‘Responses’ and choose ‘Open
results in Excel.” This will open the results in an online Excel table, which is
automatically created and saved to the general folder in HCS Tech. To move this file to
the project folder, click on the name of the file.

B8  [Review Name] Critical Appraisal Checklists @ 4 ~

e Then, click the dropdown arrow, and in the ‘Location’ box, select the right-facing arrow
to browse to the folder [ProjectName]>Project Stage>Screen, Extraction, Appraisal.

e Finally, click ‘Move here’ to relocate the file.

This Excel file will automatically update as new responses are received. Note that it may
take some time for updates to appear if the file is opened immediately after submitting a
response.

Importing Responses to the Review Tool

Once the responses have been exported into excel, the Lead Author should copy and paste
the results from the Excel file generated by the form into the ‘4. CA Tables’ sheet. To do
this, either press Ctrl + A to select all the data or click on the first cell of the first entry and
drag across until the end is reached. Once selected, copy the data and paste it directly into
the Review Tool.

Note: The sheet ‘CA Tables’ in the review tool is automatically populated with the exact
number of columns from the downloaded Form responses, which are the same number and
location in every Form based on the template.

To help with visualising the data on this table any cells which are blank have been

conditioned to remain a dark grey colour.

Quality Scoring and Report Categorisation Process

Quality Score

At this stage, a quality score for methodological quality risk will be assigned to each report
that passed the screening questions. This process is conducted automatically (last two
columns of the ‘4. CA Tables’ sheet).

The quality score is calculated as follows:

e Any questions in the checklist marked as ‘N/A’ (Not Applicable) are excluded from the
total number of applicable questions that account toward the calculation.

e Responses marked as ‘Can’t Tell’ or ‘Unclear’ are treated as a ‘No’ answer.
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For example, if a checklist has 10 questions and the report assesses 7 as 'Yes', 1 as
‘Unclear’, 1 as 'No', and 1 as N/A, then the final score is 78% (7 'Yes' answers out of 9
applicable questions).

Note: For experimental non-human studies, where a checklist is currently not available, the
cells in the ‘Quality Score’ column will be marked as ‘N/A’. Additionally, if a report does not
pass the screening questions, the final score will be marked as ‘N/A.

Methodological Quality Assessment

A methodological quality assessment is also automatically calculated in the 'Assessment
Column' to be used for the next stage — assessing confidence in the evidence. Based on
the final score, reports will be categorised as follows:

e Very minor methodological limitations/risk of bias: 76-100%
e Minor methodological limitations/risk of bias: 51-75%
e Moderate methodological limitations/risk of bias: 26-50%

e Serious methodological limitations/risk of bias: 0-25%

Note: For experimental non-human studies, where no checklist is currently available, the
cells in the ‘Assessment’ column will be marked as ‘No assessment’.

When to Exclude a report due to Methodological Quality

As standard, studies with serious methodological limitations will be excluded from the
review, and the PRISMA diagram should be updated accordingly, citing "serious
methodological quality/risk of bias" as the reason for exclusion.

The same applies to reports that did not pass the screening questions. In this case, the
exclusion reason should be "serious methodological quality/risk of bias — didn't pass
screening questions".

When a report is excluded from the review due to methodological quality:

e Its assessment and final score must still be reported in the final tables produced for
methodological quality/risk of bias assessments.

e It should be indicated in the ‘Results’ section of the literature review report.

e The references should be included in final table of excluded reports citing the reason
"serious methodological quality/risk of bias" or “serious methodological quality/risk of
bias — didn't pass screening questions".

At this stage, to facilitate referencing for the final report, the EndNote library for the review
should be opened, and all the included reports should be added to the ‘Included’ folder.

Second reviewer conducting 30 % check

This section applies only to literature reviews requiring a 30% check.
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The '30% Check' button has been set up to randomly assign reports for the supporting
author to check, based on the total number of critical appraisals recorded. When clicking
this button, the reports that need to be checked will appear with a 'Y" in the '30% Check’
column, indicating that the supporting author must review these reports. If new critical
appraisals are added, the button can be clicked again to ensure the 30% check covers all
included studies. This will not change the already allocated.

When the supporting author completes the check of a CA, they should add a comment in
the relevant cell stating 'Check completed' to indicate that the critical appraisal has been
reviewed. If discrepancies are identified and further discussion with the Lead Author is
required, this should be noted in the comment. The Lead Author should be tagged in the
comment using @ followed by the Lead Author's name.

If the Lead Author disagrees with the comments, they should add their own comments and
initiate further discussion. Once resolved, click 'Resolved' but the original comments should
not be deleted, as they need to be kept for our records.

If any changes to the current responses are made, the cell should be shaded green.

Generating and Including Methodological Quality Assessment Tables

A table with the methodological quality assessments for each study design must be
generated and included as an appendix in the final literature review report.

To do this, navigate to the ‘4. CA Tables’ sheet. In cell L1 (highlighted in yellow), use the
drop-down list to select the relevant study design. Once selected, the table will
automatically filter to display only the rows and data related to that specific study design.

Templates for each study design have been created to streamline the process. These can
be accessed in the document Appendix E: Critical Appraisal Assessment Tables Template.
Copy the relevant study design templates into the literature review template for the final
report.

To include the data in the table templates, copy the entries from the columns labelled ‘Study
Citation’ to ‘Quality Score.” Then, paste them directly into the final tables using the ‘Use
Destination Styles’ paste option. To exclude the comments column, hold down Ctrl and click
the mouse to deselect it.

9. Data Extraction

The Lead Author is responsible for extracting the data of all the included reports. The level
of involvement of the Supporting Author depends on the type of review and the agreement
at the initiation stage.
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Data needs to be extracted using the sheet named ‘3. Data extraction’ of the Excel Review
Tool. The Data Extraction table features predefined columns consistent across all literature
reviews. To accommodate specific data requirements unique to a particular review, as
outlined in the Protocol, additional columns may be added.

Pivot tables that summarise key data extracted from the "3. Data Extraction" sheet should
be used. These tables are important for assisting in the writing of the results section of the
final literature review report. The tables can be tailored for each review by selecting specific
extraction categories.

For some pieces of evidence, certain columns may not be applicable; in such cases, 'NA'
should be entered. If a specific item or data is not documented in the report, 'NR" (Not
Reported) should be used.

If additional information or clarification is required from the authors during data collection,
the authors should be contacted directly. A record of all correspondence with each study's
authors must be maintained in the folder [ReviewName]>Administration>Correspondence.

Each report must be also assessed for relevance during the data extraction stage. A rating
of directly, indirectly, partially, or unclearly relevant should be assigned to each report,
accompanied by a brief explanation. Section X of the confidence level assessment should
be consulted for further guidance on how to assess the ‘Relevance’ of a report.

Supporting Author Review

This section applies only to literature reviews requiring to be checked by the supporting
author.

When the supporting author completes the check of a reference, a comment should be
added in the ID cell stating '‘Check completed' to indicate that the specific reference has
been reviewed.

If discrepancies are identified and further discussion with the Lead Author is required, this
should be noted in a comment within the relevant cell. The Lead Author should be tagged in
the comment using @ followed by the Lead Author's name. If the Lead Author disagrees
with the comments, additional comments should be added to initiate further discussion.
Once resolved, click 'Resolved,’ but the original comments should not be deleted, as they
must be kept for records.

If any changes to the current responses are made, the cell should be shaded green.

Notification and Coordination with the Information Officer

At this stage, it is important to provide an estimate of the time required for completing the
confidence assessments and the final write-up. The Information Officer should be contacted
one month before the final review report is expected to be ready for consultation.
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SOP Literature Reviews
10. Evidence Synthesis and Confidence
Assessments

The Lead Author is responsible for conducting both the evidence synthesis and the
confidence assessments for each finding. These should be carried out simultaneously for

each finding. For new and less experienced HCSs, the confidence assessments should be
done with support from a more experienced HCS.

Evidence Synthesis

The synthesis method must strictly adhere to what is stipulated in the protocol. Any
deviations from this protocol must be formally amended in the final approved version of the
protocol and documented accordingly.

When writing the synthesis, it is recommended to use introductory phrases such as:
e "An observational study recommends/finds..."

e "The findings from an observational study suggest..."

e "This literature review identified two experimental studies..."

e "Observational studies conducted in healthcare settings consistently observed..."
e "The results of five observational studies suggest..."

e "An experimental study conducted in a residential setting suggests that..."

e "Contradictory evidence was observed by two studies..."

e "WHO guidance recommends that..."

e "Guidance from the HSE states..."

Confidence Assessments

Assessing the confidence in the evidence enables transparent assessment of how much
confidence can be placed in the review findings from the syntheses of the literature reviews.

The methods for assessing the confidence in the evidence are often subjective and cannot
be implemented mechanically. Thus, a degree of subjectivity is unavoidable in each
decision. Two authors evaluating the same body of evidence might reasonably arrive at
different conclusions regarding its confidence. Therefore, conducting this process through
discussion with the review team and thoroughly documenting every decision is essential.

To conduct the assessments, the 'Confidence Assessment Table' template should be used
and titled '[Review Name] Confidence Assessment Table'.
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Approaches for Assessing the Confidence in the Evidence

The approach for assessing the confidence in the evidence for each finding will depend on
the type of evidence included in the review. Therefore, for literature reviews that include:

e a mix of different evidence sources such as qualitative, quantitative, grey literature, and
expert opinion, the Confidence Assessment of Integrated Findings method developed by
the HCS Technical Team should be used.

e only qualitative evidence, use the criteria and guidelines provided by GRADE for
qualitative reviews (GRADE-CERQual).

e only of quantitative evidence and have the potential for meta-analysis, follow the
GRADE guidelines for quantitative literature reviews.

e only of quantitative evidence and does not have the potential for meta-analysis, follow
the method developed by the HCS technical Team.

Confidence Assessments of Integrated Findings

The first step is to produce a summary for each finding. This summary should not include
references, and it is based on the synthesis of that finding.

If there are contradictions within the evidence, these must be explicitly addressed in the
finding summary and asses the contradiction under the criteria of coherence.

Once a summary has been produced, proceed with the assessment based on the following
criteria (described in more detail in the following sections):

e methodological limitations (reliability),
e relevance,

e adequacy,

e coherence, and

e publication bias.

Each criterion will be assessed as ‘No or very minor concerns’, ‘Minor concern’, ‘Moderate
concerns’ and ‘Serious concerns. All criteria have the same weight in the final assessment.

Note: Government policy, regulations, legislation, and mandatory standards that apply to
Scotland are considered mandatory, and no confidence assessments should be conducted
for this evidence. Similarly, guidance that has scored above 60% in the AGREE Tool should
be assessed as high confidence.

Criteria 1: Methodological limitations (reliability)

Two primary factors determine the level of concern for this component:

e Critical appraisal score: This refers to the score the report received based on its
methodological quality or risk of bias assessment (refer to Section X).

Month 2024 V00.5 (Draft) Page 40 of 61



10.14.

10.15.

10.16.

SOP Literature Reviews

e Study design: Study designs that are considered more rigours and have a lower
susceptibility of bias have more weigh in this assessment. For example, high quality
meta-analyses and randomised controlled trials (RCTs) carry more weight than quasi-
experimental studies or expert opinion. Table 10.1 provides further guidance.

Table 10.1 - Levels of Evidence

1. High quality meta-analyses, systematic reviews of RCTs, or RCTs with a very low risk of bias

3. Meta analyses, systematic reviews of RCTs, or RCTs with a high risk of bias

5. High quality case-control, cohort studies or controlled pre- and post-intervention studies with
a very low risk of confounding, bias, or chance and a high probability that the relationship is

6. Well conducted case control, cohort studies and controlled pre- and post-intervention studies

relationship is causal

7. Case control, cohort studies or controlled pre- and post-intervention studies with a high risk
of confounding, bias, or chance and a significant risk that the relationship is not causal

8. Non-analytic studies, e.g., case reports, case series, qualitative studies

9. Expert opinion

However, given the diversity of topics and evidence in our reviews — including human and
non-human subjects — the weighting of different study designs should be adapted based on
each review's specific context and needs. This flexibility allows to appropriately value the
contributions of various types of studies to the topic.

e In reviews combining qualitative and quantitative data, qualitative studies will not

automatically be deemed less rigorous than RCT. Their relevance and weight will be
assessed based on the context and nature of the research question.

e In areas were conducting RCTs is not feasible, this limitation will be considered,
potentially leading to re-evaluating the weight given to alternative study designs.

e For non-human-related reviews, where RCTs are not applicable, emphasis will be
placed on controlled laboratory and in situ experiments and in vitro and simulation
studies, which may be considered more suitable and rigorous for those specific fields.

All decisions regarding the level of concern attributed to the reliability component must be
explicitly documented and justified in the assessment table, including detailed explanations
for deviations from standard study design hierarchies.

When completing the reliability component in the ‘Confidence Assessment Table’, include
the number of reports for a specific study design followed by their methodological quality
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scores. For qualitative study designs, indicate only "qualitative" without specifying the type
of study design.

For example:

¢ 3 Qualitative (2 Moderate, 1 Serious)

e 1 Quasi-Experimental (Very Minor)

e 2 Controlled laboratory experiment (1 Minor, 1 Serious)
e 2 Guidance documents (grey literature)

e 3 Expert Opinion

Note: If a finding predominantly relies on grey literature or expert opinions, the level of
concern for reliability should be classified as ‘Moderate' or 'Serious'. This stance is due to
the potential for biases and the non-peer-reviewed nature of these sources, which typically
require more critical scrutiny to confirm their validity.

Criteria 2: Relevance

The relevance component examines how well each report's context, characteristics, and
conditions align with those specified in the review question. Relevance ensures that the
studies included do not just fit broad criteria (inclusion/ exclusion criteria) but are relevant to
the specific questions and objectives of the review.

Note: It should not be mistaken relevance with the inclusion-exclusion criteria. For example,
some reports might meet all inclusion criteria but only partially address the specific research
guestions or do so in a slightly different context. For example, in a literature review aiming
to inform a decision on the use of mass timber for healthcare buildings, the lack of focused
reports on healthcare may require including evidence related to buildings in other settings,
such as universities and government facilities.

Each piece of evidence (i.e. empirical studies, expert opinion, grey literature) should have
been assessed for relevance and be recorded in the Data Extraction Table of the Review
Tool, along with a short explanation.

Relevance is rated as direct, indirect, partial, or unclear relevance.

e Direct relevance: When the evidence of a report directly addresses the review
guestion, providing specific evidence on the effectiveness, outcomes, or impacts of an
intervention or phenomenon within the exact context or population specified.

e Partial relevance: Part of the context of the review question (such as population
subgroup, settings, so on) is addressed directly but where evidence is lacking for the
complete context specified in the review question.

e Indirectly relevance: In some instances, when the team is unable to identify reports
that fully represent the context of the review, it can be decided to identify studies that
correspond with some elements from the context of the review question but not with
others.
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e Unclear Relevance: Occurs when it is challenging to determine how well the report
findings align with the review question due to missing or inadequately detailed
information. The reports under consideration fail to report these details sufficiently.

10.22. Key aspects to consider for assessing relevance:

e Population characteristics: Evaluate whether the characteristics of the population in
the evidence align with those specified in the review question.

e Setting characteristics: Assess how closely the setting of the report mirrors the context
of the review question. For example, the setting and place could be considered in terms
of physical location (such as urban vs. rural), type of study (such as laboratory setting vs
in-situ within a hospital), type of institution (such as private vs. public), type of building
(such as hospital vs. residential), characteristics of the facility (such as mental health vs
geriatric vs general healthcare facilities), socioeconomic context (such as low income vs.
high income), and so on.

e Temporal characteristics: Consider when the data were collected and any significant
changes that might affect the relevance of the findings.

e Phenomenon of interest/intervention characteristics: Assess if characteristics of the
intervention or phenomenon are clearly reported and relevant to the review question. A
lack of reporting concerning the intervention/ phenomena of interest raises concerns
regarding the study's relevance to the review question.

Examples:

Scenario Description Review question Assessment of Relevance

elements/context

A literature review The population in the Direct Relevance:
focusing on adult mental review question is adult Studies conducted entirely
health facilities. The initial | with mental health within adult mental health

search yields studies that | diagnosis. This means that | facilities. These directly
encompass a broad range | studies primarily based in address the research question.

of participants in the paediatric mental health Partial Relevance:
population samples, and geriatric populations Studies in mental healthcare
including geriatric might not directly meet the | facilities that include multiple
patients, disabled criteria. types of populations in the
individuals, children and study sample (such as, a mix
adolescents, and adults. of geriatric, children and adult

with mental health diagnoses).
These might provide valuable
insights but are not fully
aligned with the specific
context of the review question
which focused on adults. They
might be used to support
findings or to discuss broader
implications.
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A literature review on the
benefits and challenges of
using mass timber in
healthcare facility
construction

While primarily focused on
healthcare settings, the
review includes studies
from other institutional
buildings to draw broader
architectural and structural
insights.

Direct Relevance: A study
examining air quality and
patient recovery rates in mass
timber-constructed healthcare
facilities.

Indirect Relevance: Research
on the acoustic properties and
energy efficiency of mass

timber in educational facilities.

A literature review on the
impact of mental health
facility design on patient
outcomes including
studies dating back to the
1980s

The inclusion criteria is
broad to capture the
evolution of facility design
from the 1980s to the
present.

Partial Relevance:

Studies from the 1980s
provide foundational data on
design elements but do not
fully cover the modern
advancements in mental
health facility design and
treatment protocols. These
studies are included to
understand historical
perspectives and their
evolution but do not address
the modern context.

10.23. Concerns with relevance should be rated as:

e No or very minor concerns: The majority (or all) of the included reports directly address
the review question. The reports collectively provide a strong alignment with the
specified context, population, and intervention.

e Very minor: Some reports directly address the review question, while others only
partially align. Collectively, the evidence covers most aspects of the question, but there

may be some gaps.

e Moderate concerns: A few studies might directly address the review question, but the
majority are only indirectly relevant. The context, population, or intervention is not well-
represented in much of the evidence.

e Serious concerns: The majority of the evidence is unclear or only indirectly relevant to
the review question. It is difficult to form a robust finding from the included studies

because of a lack of relevant detail or context alignment.

Criteria 3: Adequacy

10.24. The adequacy criteria assesses whether the data is sufficient to robustly support the finding

claim — i.e. does the data collectively (from one or several reports) cover the necessary
breadth and depth required to fully understand and support the finding? To assess
adequacy, both data richness/depth and data volume need to be assessed holistically.
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Data richness/ depth: This only applies to findings that include qualitative data and/or
expert opinion/grey literature (excluding non-pee reviewed studies)

e For qualitative data: Assess how deeply qualitative data explores participants'
experiences, settings, contexts, etc.

e For expert opinion/grey literature: Assess the extent of these reports contribute to a
deeper understanding of the topic beyond what is available from empirical data.

Data volume: Consider the overall amount of data supporting the finding across all
sources:

e Number of studies
e Number of observations

e Sample size (only applies to quantitative data - do the studies have an adequate sample
size that can provide the statistical power necessary to detect a significant effect if one
exists?)

e Number of samples or experiments run

While there is no fixed rule about what constitutes a sufficient number of studies, sample
size, number of samples or observations, it is likely to have less confidence in a review
finding that is supported by data from only one or very few studies, participants or
observations. This is because when only few studies or studies with small samples, we are
less confident that studies undertaken in other settings or groups would have reported
similar findings.

Criteria 4: Coherence

The coherence of a review finding is an assessment of how clear and cogent the fit is
between the evidence/ data from the reports and the review finding.

Examples of coherence issues:

e The summary of a finding might only describe the most dominant patterns in the data
and does not sufficiently capture the presence of ‘outliers’ and/ or ambiguous elements
in the data. By outlier, we refer to data that do not fit the dominant data patterns across
the different reports forming the finding. For example, some contradictory data was
omitted in the review finding — more common in descriptive findings —, because review
authors either wanted to highlight only the dominant patterns or addressed a specific
policy or guideline question requiring a narrower response. In these cases, the evidence
that is not well captured within the review finding may be considered a threat to
coherence.

e Key aspects of the underlying data may be vaguely defined or described. In these
cases, the supporting data are not clearly or sufficiently described, and cannot always
be sure that the data in fact clearly support the review finding. Elements of the
underlying data may be defined in slightly different ways across different reports. In
these cases, the data may appear reasonably comparable, but we are not sure if they
are comparable.
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e More interpretive or explanatory review findings are often more complex and include
several aspects, e.g. descriptive data, ideas, concepts or relationships. We may have
strong evidence from the underlying data for certain aspects of the review finding, but
insufficient data to support other aspects of the interpretation or explanation. These
gaps in the evidence for an interpretive or explanatory review finding are not
contradictory data, but rather the absence of data in certain places. When the data
provide this kind of incomplete support for a review finding, you may have concerns
about the coherence of a finding.

Identifying and addressing coherence issues:

e During the review, if the authors find that the finding summary does not quite fit with all
the data/evidence, they may need to revise the finding. This process checks if the
summary has overly simplified the data or overstretched an explanation too far beyond
what is supported by the data/evidence.

e The goal is not to achieve perfect coherence but to ensure there are no significant
concerns about coherence that might reduce confidence in the findings.

e In some cases, findings with series coherence concerns may still be helpful if they
highlight important considerations, even if they do not align perfectly with all the
data/evidence.

e When assessing coherence, it may also be necessary to return to the primary studies or
develop further coding if details necessary for assessing how well the data support a
particular review finding were not initially captured in the data extraction table.

When there is clear and cogent support for a review finding across the underlying data,
there should not be serious concerns about the coherence of the finding. Concerns about
the coherence of the fit between a review finding and the underlying data may arise when
patterns in the data are not well explored or explained, either by the review authors or the
primary study authors.

Criteria 6: Publication bias assessment

Publication bias refers to the tendency for studies with positive or significant findings to be
more likely to be published, while studies with negative or non-significant results are less
likely to appear in the published literature. This can lead to a distorted or unbalanced view
of the available evidence.

Key factors to assess for publication bias include:

e Diversity of studies: If the finding is supported by only a few studies, particularly those
published in high-impact journals, there is a greater risk that studies with non-significant
or negative results are missing from the evidence base, skewing the conclusions. A
larger and more diverse set of studies reduces the risk of publication bias.

e Reporting patterns: Investigate whether there are discrepancies between the study
protocols and published reports. For instance, if planned analyses or outcomes
mentioned in study protocols are missing from the final publication, this could be a sign
of publication bias.
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e Grey literature inclusion: Studies found in grey literature (e.g., reports, theses,
conference papers) may reduce the risk of publication bias since they are not influenced
by the same pressures as peer-reviewed journals.

e Funnel plot analysis (if applicable): For meta-analyses, a funnel plot can be used to
visually assess potential publication bias. A symmetrical funnel suggests no bias, while
asymmetry may indicate its presence.

Concerns about publication bias should be rated as:

e No or very minor concerns: The body of evidence includes a large number of studies
from diverse sources, with no clear indication of missing or unreported data.

e Minor concerns: The evidence base is relatively comprehensive, but some
discrepancies in reporting or an absence of grey literature raise mild concerns about
publication bias.

e Moderate concerns: The evidence base is smaller or predominantly from high-impact
journals, raising the likelihood that studies with null or negative results are
underreported.

e Serious concerns: A very limited number of studies are available, and there is a high
likelihood of publication bias, either due to the selective reporting of results or the
absence of non-significant findings.

Final assessment

For the final assessment, the level of concern for each criterion will inform the confidence in
the review finding. The level of confidence in a review finding can be high, moderate, low or
very low.

e High confidence: Indicates strong, consistent evidence from multiple high-quality
reports. There is little or no doubt about the reliability of the finding.

e Moderate confidence: Reflects some level of uncertainty due to variability in the
evidence. The findings are likely reliable, but there are some concerns regarding the
quality, quantity or consistency of the evidence.

e Low confidence: Represents substantial uncertainty about the findings. The evidence is
limited or inconsistent, raising questions about the reliability of the finding.

e Very low confidence: Shows high uncertainty and indicates that the finding may not be
reliable due to significant limitations in the evidence.

All review findings start off by default as ‘high confidence’ and are then ‘rated down’ by one
or more levels — for example, from high to moderate confidence if there are concerns
regarding any of the components. In practice, minor concerns will not lower the confidence
in the review finding, while serious concerns will lower the confidence. Moderate concerns
may lead to consider lowering the confidence in your final assessment. Having concerns
about one criterion may not necessarily lead to a downgrading of overall confidence in a
review finding, as the final confidence has to be assessed alongside the other three
components as a whole. Each component of the confidence in evidence assessment
weights equal in the assessment.
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In addition, in the absence of strong empirical evidence, if a finding is predominantly based
on evidence from grey literature or expert opinion, the level of confidence should be low due
to serious concerns.

Agree on Confidence Assessments

The first draft of the ‘Confidence Assessments Table’ document, once completed, should be
sent along with the synthesis document to the Supporting Author for feedback. This should
remain the same version number, even if amendments are required.

Once both authors are content with the confidence assessments and synthesis, the Lead
Author should incorporate them in the literature review draft and send it to the Lead/
Principal HCS for review. After receiving feedback, make any required amendments and
change the version draft number.

A meeting should be scheduled with the SME using the Email Template to discuss the
confidence assessments and recommendations for further research.

For extensive literature reviews, two meetings may be necessary. Send the literature review
report draft with confidence assessment tables to the SME for review prior the meeting. If
the SME has not previously been involved in this process, it could be beneficial to arrange a
brief call once the documents have been sent to explain how the assessments are
conducted prior the meeting takes place.

During the meeting, an agreement should be reached with the SMEs for each assessment
and the suggested recommendations for future research. The Lead Author should
incorporate feedback and finalise the confidence assessment tables.

The Confidence Assessment Table document should be included as an appendix in the
final report. A summary table will be produced and provided within the Discussion section of
the report, following the template ‘Confidence Assessment Table Summary’.Stage 5: Write
up and Publication.

11. Write -Up and Publication

Write-up the Literature Review Report

The Lead Author is responsible for drafting the final report using the 'RN Final Report'
template. This draft should be proofread by the Supporting Author and undergo a sense
check by the Lead/Principal HCS. After feedback is incorporated, the draft should be sent to
the SME for review, allowing them a full working week for the review process.

The Lead Author should then integrate the SME's comments and, if necessary, organise a
meeting with the SME to finalise the consultation draft. Ideally, this meeting should also
include the Lead/Principal HCS and the Supporting Author, if available.
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Final sign-off must be obtained from the relevant SME/Commissioner before the draft is
sent for consultation. The template email named ‘Literature Review Draft approval for
consultation’ should be used to seek agreement on the draft. The email with the approval
from the SME should be saved in the 'consultation’ folder.

Once approved and before being sent for consultation, the draft should be sent to the
Information Officer to check for accessibility and branding. Ensure that the email with the
approval for consultation from the Information Officer is saved in the ‘consultation’ folder.

Recommendations for practice and further research

For literature reviews, recommendations for practice are not often provided. It is the
responsibility of the SMEs to make recommendations based on the review findings and
confidence assessments. However, for some journal articles, recommendations for practice
may be required. In this case, they must be developed in consultation with the SME.

When providing implications for further research, these can be categorised as general and
specific.
e General implications for research: These recommendations are aimed to the wider

academic and professional community, focusing on gaps within the existing knowledge
and areas where conflicting data is identified in the literature review.

e Specific implications for research: These are the recommendations the commissioner or
SME would like to pursue further through primary research

Despite identifying two types of implications for further research, the final report does not
need to establish this distinction and can report all under the ‘Implications for further
research’ section. The distinction is made for internal purposes only.

All implications for research, both general and more specific, will be documented in the
Research Repository file. The recommendations the commissioner would like to pursue
further through primary research will be documented in the Research Themes file.

The Lead Author is responsible for reporting the recommendations for practice to the
Research Service Project Management Team and cc'ing the Lead/Principal HCS.

How to reference in the final report

For literature reviews not intended for publication in a peer-reviewed journal, the Vancouver
referencing system should always be used. If the review is intended for a journal, the
journal's preferred referencing system must be followed.

When using the Vancouver system:

¢ Including authors' names in the main text should be avoid. For example, instead of using
phrases like "Sanz et al. (2024) identified...", use phrasing such as "Two qualitative
studies identified..."
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e Organisations can be cited within the text (e.g. The World Health Organisation
recommended...).

e Reference numbers should be placed after punctuation. For example, "One study found
that the in-board design of the bedroom negatively impacted all users,* while another
study found it only negatively impacted the patient user group.? Or: it was identified that
privacy in rooms improve wellbeing,*%8 sleep quality, ®*? and satisfaction with the
environment.?

Appendixes in the final report

The final report should include the following appendices:

e Appendix A. Search terms and search strategies — These are available in file named
‘[Review Name] Search Strategy’

e Appendix B. List of excluded reports with reasons for their exclusion after the second
screening — See section X on how to create these tables.

e Appendix C. PRISMA flow diagram — [Review Name] Prisma Diagram file

e Appendix D. A table summary detailing the main characteristics of all the included
reports - See section X on how to create these tables.

e Appendix E. Critical appraisal assessment tables — See section X on how to create
these tables

e Appendix F. Evidence grading assessment tables — [Review Name] Evidence
Assessment Table file.

How to Create a Table for Excluded Reports

The 'A Excluded' tab in the Review Tool contains three tables:
e Table 1: Reports excluded during the second screening through the database search.

e Table 2: Reports excluded during the second screening through the citation search.

e Table 3: Reports excluded due to concerns about methodological quality.

In the 'Appendix 3' Word document, Table 1 should be pasted. If applicable, the second
table should be merged with the first, and the same should be done for the third table. The
tables contain IDs that need to be replaced with Vancouver-style references. To achieve
this, the EndNote library for the Review should be opened, and each reference ID manually
searched. The corresponding reference should then be dragged and dropped into the table.
Once all references are added, they should be sorted alphabetically, which can be done
automatically.

Consultation

The consultation draft will be sent to the consultation groups/members for a two-to-four-
week consultation period, depending on the complexity of the review. For rapid reviews, if
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applicable, the consultation period should be 1 to 2 weeks. The draft should be
accompanied by the Final Report Evaluation Tool. If the review is an update, any changes
should be clearly highlighted.

Following the agreed consultation period, the Lead Author will collate all comments, if any,
into one document using the RN Consultation Template and name it '[Review Name] Report
Consultation Response’. This should be saved in the folder [ProjectName]>Project
Stage>Write up.

The Lead Author and allocated SME will review all comments from the consultation and
draft suitable responses to these comments. Any amendments should be discussed and
agreed upon. The Supporting Author should be involved if available.

If amendments are required, the Lead Author will then make the amendments and send the
report back to the SME/ Commissioner for final sign-off using the email template ‘Final
Version Sign-Off’.

Any edits made during the consultation and sign off process including decisions made and
by whom and rationale, must be reflected retrospectively in the relevant confidence
evidence tables.

Final Literature Report and Publication

The Lead Author must ensure that a copy of the final formatted word document is tagged as
‘Final Version’. This version should be shared with the Lead/Principal HCS for final approval
before sending it to the Information Officer for the final checks.

Following approval from the Information Officer for publication, the Lead Author is
responsible for conducting a final read-through to check for any errors.

The Lead Author should send the final versions of the literature review report and protocol
to the Information Officer for uploading to the NHSScotland Assure website. Once
uploaded, the Lead Author should inform the Website Content Owner, who will include the
links to the publications. Further instructions on how to add and modify website content can
be found in Folder [xxx].

12. Actions Following Publication

Set up alerts

Some literature reviews may need to be reviewed within an agreed period of years. If this is
the case, alerts can be set up at regular intervals (e.g., every few months) to identify
whether any key evidence has emerged.
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Update research repository Literature Reviews

The Lead Author is responsible for emailing the Research Service Project Management
Team,? specifying the general and specific implications for research for the review project
and indicating the completion date of the project (this is the final sign-off).

Quality assurance

It is the responsibility of the Lead Author to ensure that all files related to the review are
stored in the correct folder. Use the Folder Structure.xlsm to perform the quality check.

13. Communication

This Version is for internal communication only. This will be distributed within the HCS
Technical Team. This will be saved in the following folder xxx/ and Q-pulse.
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SOP Literature Reviews
Appendix A Systematic and Scoping Reviews

Systematic Literature Reviews

In a systematic literature review, a difference from a scoping review, the question is more
specific, clearly defined and addresses specific research objectives, such as evaluating the
effectiveness of interventions, identifying relationships between variables, exploring
gualitative insights like perceptions and experiences. It is particularly suited for when
decision-makers require concrete answers, informed by the best available evidence to
guide practice recommendations.

Systematic literature reviews are more suitable if the field is more mature and has
substantial research. However, in some cases, a systematic literature review may identify
that the available evidence is insufficient to provide comprehensive insights or conclusive
answers for some questions. In such cases, the review may conclude that the current
evidence is insufficient to support definitive conclusions, highlighting the need for further
research and providing recommendations for future studies.

Note: In academia, the term ‘systematic literature review’ often refers to reviews that
include only qualitative or quantitative data from empirical studies. When qualitative and
guantitative data from empirical studies are combined in a literature review, it is known as a
mixed methods review. When reviews incorporate various types of evidence, such as
empirical studies (qualitative or quantitative), grey literature, and expert opinion (such as
interviews, consultations, articles based on expert insights, editorial papers, and so on),
they are referred to as ‘integrative systematic review’. To avoid confusion, for our reviews
we used the term ‘systematic literature reviews’ regardless of the type of data or evidence
considered. However, if the study is to be published in a journal, the title of the literature
review should align with the terminology preferred in academia.

Scoping Review

A scoping review aims to map the existing literature on a broad topic to identify the types
and sources of evidence available, key concepts, and gaps in research. It is particularly
useful for emerging fields or complex, multifaceted topics where the scope of the research
is not well-defined or with limited research available.

To determine if a scoping literature review is appropriate for the topic, consider whether the
review aims align with the following objectives of a scoping review:

e Evidence mapping: identify the types of available evidence in a given field.
e Concept clarification: clarify key concepts/ definitions in the literature.

e Methodological exploration: examine how research has been conducted on a certain
topic or field.

e Characteristic Identification: key characteristics or factors related to a concept.

Month 2024 V00.5 (Draft) Page 53 of 61


https://www.sciencedirect.com/science/article/pii/S1355184120300715

SOP Literature Reviews

e Systematic review precursor: Assess the feasibility and inform the development of a
subsequent systematic review.

e Gap analysis: identify and analyse knowledge gaps.

If the review topic meets one or more of these objectives, then a scoping review would be
appropriate.

Note: Scoping reviews do not include a critical appraisal of the methodological quality/ risk
of bias of included reports. Recommendation for guidance should not be provided based on
the findings from a scoping review.

When to conduct a scoping review as a precursor to a systematic literature review

e When the initial search indicates that the available studies are highly varied in their
designs, methodologies, populations, interventions, or outcomes, it can be challenging
to synthesise the evidence in a meaningful way. A scoping review helps to map out this
diversity and categorise the studies, which can reveal patterns and guide the
development of a more focused and feasible systematic review.

¢ When the research field is new or emerging, and the exact reviews guestions are not
well-defined, a scoping review can help clarify the key concepts, definitions, and the
scope of available research. This process can help refine research questions and
develop a more targeted systematic review.

e When there is a need to explore a broad area to understand the range of existing
literature, a scoping review provides an overview that can identify gaps and inform the
formulation of specific, focused questions for a systematic review.

e When there is uncertainty about the extent, range, and nature of research conducted in
a particular area, a scoping review can help to map out what has been studied or
published in the literature, the types of evidence available, and the key characteristics of
the research landscape. This mapping can reveal gaps and areas where more a
systematic review can be conducted.
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Appendix B Key Characteristics Across Review Types

Stages Systematic Rapid Reviews Scoping Reviews
Literature Reviews

Authors e Two authors e One author e One or two authors

Search e All relevant e Conducted in e All relevant
databases general databases

e Citation search databases. e Citation search
e Grey literature * Specialised e Grey literature
. database . .
search (if hes limited search (if applicable)
applicable) searches limite
to 1-2 sources.
e Citation searching
and grey literature
may be restricted.
Study e One author
Selection screen titles and
abstracts and full
texts of eligible
studies.

Data Extraction | ¢ | ead Author  Data extraction e Lead Author extracts
extracts data may be limited to data using a piloted
using a piloted essential items; form.
et EXISStgrr]I?atiC e Supporting Author

e Supporting rgviews can be checks 30% of the
Author checks all data extracted.
used.
extracted data.

Critical e Lead Author e No critical e No critical appraisals

appraisal conduct the appraisals required
critical appraisals required

e Supporting
Author does 30%
check.
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Systematic Rapid Reviews Scoping Reviews

Literature Reviews

Confidence e Collaboration e SME consultation | e No confidence
Assessments among Lead, if time allows. assessments
Supporting e Use proxy performed.
Author, .
. indicators for the
Lead/Principal methodological
HCS, and at ualit critgrion
least one SME. quaiity '
Consultation e Yes e Not required e Yes
Publication e Yes e Not required e Yes

Month 2024 V00.5 (Draft) Page 56 of 61



	Structure Bookmarks
	• 
	Table 2.1 – Column description and input required in the Literature Review Timeline file 
	• 


